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	Country Name
	Country Code
	1999
	2000
	2001
	2002
	2003
	2004
	2005
	2006
	2007
	2008
	2009

	Kosovo
	KSV
	
	
	57
	55
	50
	40
	41
	45
	46
	48
	45

	Macedonia, FYR
	MKD
	32
	32
	31
	32
	37
	37
	37
	36
	35
	34
	32

	West Bank and Gaza
	PSE
	12
	14
	25
	31
	
	27
	
	24
	22
	26
	25

	South Africa
	ZAF
	25
	27
	29
	30
	31
	26
	27
	26
	23
	23
	24

	Ethiopia
	ETH
	8
	
	
	
	
	23
	5
	17
	
	
	21

	Spain
	ESP
	16
	14
	10
	11
	11
	11
	9
	9
	8
	11
	18

	Latvia
	LVA
	14
	14
	13
	13
	11
	10
	9
	7
	6
	7
	17

	Serbia
	SRB
	
	
	
	
	
	19
	21
	21
	18
	14
	17

	Bahamas, The
	BHS
	7
	
	7
	9
	11
	10
	10
	8
	8
	9
	14

	Turkey
	TUR
	8
	6
	8
	10
	11
	11
	11
	10
	10
	11
	14

	Estonia
	EST
	12
	13
	12
	10
	11
	10
	8
	6
	5
	5
	14

	Lithuania
	LTU
	13
	16
	17
	13
	13
	11
	8
	6
	4
	6
	14

	Puerto Rico
	PRI
	12
	10
	11
	12
	12
	10
	11
	11
	11
	12
	13

	Jordan
	JOR
	
	
	16
	16
	15
	12
	
	
	13
	13
	13

	Slovak Republic
	SVK
	16
	19
	19
	19
	18
	18
	16
	13
	11
	10
	12

	Colombia
	COL
	20
	17
	14
	14
	14
	12
	11
	12
	10
	11
	12

	Ireland
	IRL
	6
	4
	4
	4
	4
	4
	4
	4
	5
	6
	12

	Jamaica
	JAM
	16
	16
	15
	14
	12
	11
	11
	10
	9
	11
	11

	Hungary
	HUN
	7
	6
	6
	6
	6
	6
	7
	7
	7
	8
	10

	Morocco
	MAR
	14
	14
	12
	12
	12
	11
	11
	10
	10
	10
	10

	Chile
	CHL
	10
	9
	9
	9
	8
	9
	8
	8
	7
	8
	10

	Portugal
	PRT
	4
	4
	4
	5
	6
	7
	8
	8
	8
	8
	9

	Greece
	GRC
	12
	11
	10
	10
	10
	10
	10
	9
	8
	8
	9

	Euro area
	EMU
	10
	9
	8
	9
	9
	9
	9
	8
	7
	7
	9

	Egypt, Arab Rep.
	EGY
	8
	9
	9
	10
	10
	11
	11
	11
	9
	9
	9

	United States
	USA
	4
	4
	5
	6
	6
	6
	5
	5
	5
	6
	9

	Europe & Central Asia (developing only)
	ECA
	12
	10
	10
	9
	9
	9
	8
	8
	8
	8
	9

	North America
	NAC
	5
	4
	5
	6
	6
	6
	5
	5
	5
	6
	9

	Upper middle income
	UMC
	11
	11
	11
	11
	11
	10
	9
	9
	8
	8
	9

	France
	FRA
	12
	10
	9
	9
	9
	9
	9
	9
	8
	7
	9

	Croatia
	HRV
	14
	16
	20
	15
	14
	14
	13
	11
	10
	8
	9

	Europe & Central Asia (all income levels)
	ECS
	10
	9
	9
	9
	9
	9
	9
	8
	7
	7
	9

	European Union
	EUU
	10
	9
	9
	9
	9
	9
	9
	8
	7
	7
	9

	Ukraine
	UKR
	12
	12
	11
	10
	9
	9
	7
	7
	6
	6
	9

	Argentina
	ARG
	14
	15
	18
	18
	16
	13
	11
	10
	8
	8
	9

	Sweden
	SWE
	7
	6
	5
	5
	6
	7
	8
	7
	6
	6
	8

	Brazil
	BRA
	10
	
	9
	9
	10
	9
	9
	8
	8
	7
	8

	Canada
	CAN
	8
	7
	7
	8
	8
	7
	7
	6
	6
	6
	8

	Finland
	FIN
	10
	10
	9
	9
	9
	9
	8
	8
	7
	6
	8

	Poland
	POL
	13
	16
	18
	20
	20
	19
	18
	14
	10
	7
	8

	Russian Federation
	RUS
	13
	11
	9
	8
	8
	8
	7
	7
	6
	6
	8

	OECD members
	OED
	7
	6
	6
	7
	7
	7
	7
	6
	6
	6
	8
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How to use this document 
This set of instructions is only a reference to remind workshop participants of all the features 


covered in the workshop. If any part of this document seems confusing, please go to 


http://ittraining.gmu.edu/ and register for the next workshop or contact University 


Dissertation & Thesis Services at udts@gmu.edu.  


How to use the template  
Most people are used to opening a blank document, typing, and then formatting the document 


to suit  their needs. Doing so is perfectly normal and expected, but doing so with this template 


will result in endless frustration. While the template does require some effort and a little getting 


used to (in that you will have to become accustomed to just typing and letting the template take 


care of the formatting), the rewards ultimately pay off. The template will automatically make 


your document 100% consistent, will conform to University standards, will do almost all of the 



http://ittraining.gmu.edu/
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formatting for you, and will automatically update things like the Table of Contents, the List of 


Figures, and other features that many people used to have to fix manually, over and over again. 


Template Sections 
We have split the template into four different sections and have named them in such a way so 


that they are easy to recognize.  The four sections are as follows:  Blank Section, Roman 


Numerals Section, Abstract Section, and Arabic Numerals Section.  At the end of each section 


you will find a Section Break, a handy little tool that breaks the document into parts that have 


different formatting rules.  A detailed explanation of what is required of you, as well as what 


goes into each section, make up the bulk of these instructions. 


Blank Section 
Since the first couple of pages of the document are not numbered, we have decided to name 


this section “Blank.”  Only two pages go into this section: the Signature Sheet and the Title 


Page. There is a section break at the bottom of the Title Page, which you must not delete, 


under any circumstances, lest you want to break the format of the entire document. 


Signature Sheet 


The Signature Sheet will vary for each person due to different requirements for different 


colleges.  A student in the College of Education and Human Development will have a completely 


different Signature Sheet from a student in the College of Science.  The Signature Sheet 


contained in this template is just a general Signature Sheet, and should not be taken as the 


required Signature Sheet for ANY school/college/department.  Please check 


thesis.gmu.edu/signaturesheets.html for the Signature Sheet that applies to your degree. 


Title Page 


Both the Signature Sheet and the Title Page contain text boxes for users to fill out.  These 


boxes have been locked to prevent users from deleting them, thereby messing up the linked 


fields throughout the document.  What you want to do is click inside the text boxes, and enter 


the information that pertains to you.  You will notice as you scroll down from the Signature 


Page to the Title Page, any fields that are linked between those two pages will now display the 


same information. 
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Roman Numerals Section (i, ii, iii, iv…) 
This section is named after the page numbering used in it.  It is composed of a series of 


optional pages, as well as a number of lists and tables to ease navigation of your document.  


There is a section break at the end of the List of Abbreviations or Symbols—it is very 


important that you do not delete this section break.   


Optional Pages 


Within this section, you will find a number of optional pages (pages you are free to delete if you 


so desire), as well as pages you are free to delete if you don’t need them.  The optional pages 


are the Copyright Page, Dedication Page, and Acknowledgments Page.  The pages you may 


delete if you do not need them include the List of Tables, List of Figures, List of Equations, 


and List of Abbreviations or Symbols.  We recommend you do not delete these pages until the 


end, in case you change your mind about including any of these objects.  Remember that there 


is a section break at the end of the List of Abbreviations or Symbols; so if you decide to 


delete this page, make sure you do not delete that section break; instead, move it to the 


previous page. 


Table of Contents 


Your ToC, LoT, LoF, and LoE  will be updated manually by pressing Ctrl + A to highlight your 


entire document, and then F9, which is the Update command.  This will prompt a dialog box 


asking if you want to update page numbering or the entire table.  You want to select the entire 


table every time these dialog boxes are prompted.  Always remember that changes will not 


show up in any of these tables or lists until you update them.  These changes include 


captioning and use of the heading styles. 
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List of Abbreviations or Symbols 


Since this list is not automatic like the rest, Ctrl + 9, F9 will do nothing to update it.  To enter a 


new item into your LoAoS, go to the last existing entry, press Enter to go to a new line, then 


type the full term on the left. Press the Tab key on your keyboard to jump over to the right. 


Enter the abbreviation or symbol on the right side, and repeat as needed.  To get them all in 


alphabetical order, highlight the list, go to the Home tab, use the Sort feature, and click the 


OK button. 


 


Abstract Section 
Notice how everything in the first paragraph of the Abstract is using the stuff you typed into 


your Signature Sheet. Use the Abstract Text style for the text of the Abstract page. The 


Abstract has a page number, which will show in the Table of Contents, but the page number 


does not show on the Abstract page itself.  The Abstract may run onto more than one page; 


because of the sections and formatting, the template will automatically adjust to this, and so 


you will not need to change anything for the formatting to be correct.  There is also a small 


drop-down menu at the top of the page, from which you can select the title you will earn 


with the completion of this degree.  Like all the other sections of this document, the Abstract 


Section has a section break at the end of its last page, so make sure you don’t delete it.   
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Arabic Numerals Section (1,2,3,4…) 
The Arabic Numerals Section will contain the bulk of your document.  This section is devoted to 


most, if not all, of your writing: chapters, sections, subsections, Appendices, and References.  If 


you have an existing document you want to paste into the template, you will have to follow a 


series of instructions.  They are painful to follow, but once you are done, everything should fall 


into place.So do not despair, and stay with me. 


Copying from an Existing Document 


If you simply copied and pasted from an existing document into the template, you would get 


the formatting from the existing document that you do not want, as well as the text that you do 


want.  Below are the steps to avoid that problem. 


First, you want to create a backup copy of your existing document, so you can experiment with 


it, in case you do not get the whole process to work the first time.  The key is to find any kind 


of formatting that might violate the rules we have set up for the template.  To eliminate them, 


we are going to use the Find and Replace feature within Word.   


Use ctrl+h to pull up the dialog box.  Type ^l in the Find text field and ^p in the Replace text 


field.  This will remove any instances of page breaks, and replace them with returns (The trick 


to get this to work correctly is to click on Replace All until you either get 0 changes or a 


repeating number)  
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For the next one, you want to find ^t and Replace with [absolutely nothing], not even a blank 


space.  This one will remove any tabs from the document.   


For the next one, you want to find ^p^p and Replace with ^p.  We use this one to get rid of any 


instances of double spacing, and replace them with single spacing.   


Lastly, you will Find [two spaces] and Replace with [one space].  Doing so one will replace two 


spaces after words or periods, and replace them with just one space.   


Now that we are done removing additional formatting, we have to change the style of our 


document so it fits the style used in the template.  Use ctrl+h one last time, to Find [absolutely 


nothing]. Be wary because you might still have the empty spaces from the last search you 


performed. This is the part where it gets confusing. At the bottom left of the dialog box there 


is a More button, which you want to click on to pull up advanced features.  Now you’ll see a 


new section at the bottom left, which says Replace and has a drop-down menu under the 


Format button.  From it, you want to select Style… and pick the Normal style from the Find 


Style dialog box.  As for the Replace field box, you will do the same up to the Find Style Dialog 


box, but this time select the Body Text style.  Doing this will change the style for your entire 


document from Normal to Body Text.   


 


The last step is to go to the Word application options, to the Advanced tab. and to change all 


the Cut, copy, and paste options to Merge Formatting.  Now you can copy and paste into the 


template. 
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Styles 


As you may have noticed from looking at the rest of the document, pretty much everything in it 


has a Style.  Unless you are familiar with Styles, you will have absolutely no idea what I’m 


talking about.  If you look in the Home tab, under the Styles group (which is found within the 


ribbon) you will see a series of boxes.  By default, the Normal Style will be highlighted.  The 


template contains a range of styles, from Body Text (which makes up the bulk of your 


document), to Headings (which will be your chapter, sections, and subsection titles), to Object 


(which will be applied to visuals).  Knowing when to use which style is key to using this 


template successfully.  But just because we’ve designed the Heading styles for you does not 


mean that they are final!  You are free to format any of these styles in any way you want, so 


long as they are consistent and do not impair readability.  .  To Format a Style, right-click on it 


from the Quick Style Gallery, and select Modify; this will prompt the Modify Style dialog box.  


Any changes you make to a style will be reflected by any text that uses it. 


To apply a style to a letter, word, sentence, or block of text, go to the line that contains it, and 


either select the style, or highlight the specific text and then select the style from the Quick 


Style Gallery 


Chapters 


Use the Heading 1 style to format all your main headings (List of Tables, List of Figures, 


Abstract, chapter titles, Appendix titles, References, etc.) correctly. Use the Heading 2 style for 


subheadings. Check with your publication manual (APA, MLA, Chicago, etc.) to make sure that 


your Headings 1 and  2 match whatever your publication manual requires.  If you followed the 


instructions listed in the “Copying from an Existing Document” section, you will notice that all 


of your chapter headings have been turned into Body Text, so you will have to reassign them as 


chapter headings by using the appropriate heading tyle.  Upon applying a heading style to text, 


that text will be added to the Table of Contents, but only once you update that field. 
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Text 


The Normal style is only used in the references section so that Zotero can format the citations. 


Pressing Enter 


When you press enter you will get a paragraph mark (^p). Most of the time, this is exactly what 


you want. This template uses manual line breaks (^l) in some places; please leave them as they 


are. 


Tables, Figures, and Equations 


Captioning the objects in your document does not have to be a chore. To make it easier for you, 


we’ve come up with a really simple system.  We call this the “Three, Two, One method,” and it 


goes as follows: 


1. You want to press the Enter key three times; turning on Show/Hide should make this 


easier. 


2. Apply the Buffer Style to the top and bottom lines. 


3. Apply the Object Style to the middle line, and then insert the object into that line. 


If you’ve done everything correctly, it should look something like this: 


 


Once you insert an object into the document using this method, you can go ahead and caption 


it so it will appear in the appropriate list (Tables in List of Tables, Figures in List of Figures, and 


so on.)  You can caption an object by selecting it, then going to the References tab and clicking 


on Insert Caption from the Captions group. You can also right-click on the object and select 


Insert Caption from the menu.  This will prompt the Caption dialog box, where you will name 


the object, select what type it is (Table, Figure, Equation), and check the position of the caption 


relative to the object.  To name the object, simply write in the text box at the top.  Once you 


change the label type, it will automatically adjust the position of the caption to either above or 


below, please note that the position of the caption is the whole reason we used two buffer lines. 
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In the case of Tables and Figures, if, instead of using a Word or Excel Table, you decide to 


include a picture of a Table, you will still need to use the Table label.   


When referring to objects within your document, avoid the urge to type out “See Figure 1” or 


any such messages, since if you add another Figure before Figure 1, Word will automatically 


renumber them, and you’ll then have to renumber any references to that Figure within your 


text.  To avoid this, you will use the Cross-Reference feature in Word.  To use this feature, 


select in your document where you want to place the reference, go to the References tab, and 


click on Cross-reference from the Captions group.  This will prompt the Cross-reference 


dialog box, from which you will select the Reference Type (If you do not see Table or Figure in 


the drop-down menu, scroll down to find them). Select how you want the reference to be 


displayed (As just the label, the whole caption, the page number, or a combination of them) 


and click on the Insert button at the bottom of the dialog box.  These references will be 


automatically renumbered if you decide to add or move your objects. 
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How to use this document 
This set of instructions is only a reference to remind workshop participants of all the features 


covered in the workshop. If any part of this document seems confusing, please go to 


http://ittraining.gmu.edu/ and register for the next workshop or contact University 


Dissertation & Thesis Services at udts@gmu.edu.  


How to use the template  
Most people are used to opening a blank document, typing, and then formatting the document 


to suit  their needs. Doing so is perfectly normal and expected, but doing so with this template 


will result in endless frustration. While the template does require some effort and a little getting 


used to (in that you will have to become accustomed to just typing and letting the template take 


care of the formatting), the rewards ultimately pay off. The template will automatically make 


your document 100% consistent, will conform to University standards, will do almost all of the 



http://ittraining.gmu.edu/
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formatting for you, and will automatically update things like the Table of Contents, the List of 


Figures, and other features that many people used to have to fix manually, over and over again. 


Template Sections 
We have split the template into four different sections and have named them in such a way so 


that they are easy to recognize.  The four sections are as follows:  Blank Section, Roman 


Numerals Section, Abstract Section, and Arabic Numerals Section.  At the end of each section 


you will find a Section Break, a handy little tool that breaks the document into parts that have 


different formatting rules.  A detailed explanation of what is required of you, as well as what 


goes into each section, make up the bulk of these instructions. 


Blank Section 
Since the first couple of pages of the document are not numbered, we have decided to name 


this section “Blank.”  Only two pages go into this section: the Signature Sheet and the Title 


Page. There is a section break at the bottom of the Title Page, which you must not delete, 


under any circumstances, lest you want to break the format of the entire document. 


Signature Sheet 


The Signature Sheet will vary for each person due to different requirements for different 


colleges.  A student in the College of Education and Human Development will have a completely 


different Signature Sheet from a student in the College of Science.  The Signature Sheet 


contained in this template is just a general Signature Sheet, and should not be taken as the 


required Signature Sheet for ANY school/college/department.  Please check 


thesis.gmu.edu/signaturesheets.html for the Signature Sheet that applies to your degree. 


Title Page 


Both the Signature Sheet and the Title Page contain text boxes for users to fill out.  These 


boxes have been locked to prevent users from deleting them, thereby messing up the linked 


fields throughout the document.  What you want to do is click inside the text boxes, and enter 


the information that pertains to you.  You will notice as you scroll down from the Signature 


Page to the Title Page, any fields that are linked between those two pages will now display the 


same information. 
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Roman Numerals Section (i, ii, iii, iv…) 
This section is named after the page numbering used in it.  It is composed of a series of 


optional pages, as well as a number of lists and tables to ease navigation of your document.  


There is a section break at the end of the List of Abbreviations or Symbols—it is very 


important that you do not delete this section break.   


Optional Pages 


Within this section, you will find a number of optional pages (pages you are free to delete if you 


so desire), as well as pages you are free to delete if you don’t need them.  The optional pages 


are the Copyright Page, Dedication Page, and Acknowledgments Page.  The pages you may 


delete if you do not need them include the List of Tables, List of Figures, List of Equations, 


and List of Abbreviations or Symbols.  We recommend you do not delete these pages until the 


end, in case you change your mind about including any of these objects.  Remember that there 


is a section break at the end of the List of Abbreviations or Symbols; so if you decide to 


delete this page, make sure you do not delete that section break; instead, move it to the 


previous page. 


Table of Contents 


Your ToC, LoT, LoF, and LoE  will be updated manually by pressing Ctrl + A to highlight your 


entire document, and then F9, which is the Update command.  This will prompt a dialog box 


asking if you want to update page numbering or the entire table.  You want to select the entire 


table every time these dialog boxes are prompted.  Always remember that changes will not 


show up in any of these tables or lists until you update them.  These changes include 


captioning and use of the heading styles. 
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List of Abbreviations or Symbols 


Since this list is not automatic like the rest, Ctrl + 9, F9 will do nothing to update it.  To enter a 


new item into your LoAoS, go to the last existing entry, press Enter to go to a new line, then 


type the full term on the left. Press the Tab key on your keyboard to jump over to the right. 


Enter the abbreviation or symbol on the right side, and repeat as needed.  To get them all in 


alphabetical order, highlight the list, go to the Home tab, use the Sort feature, and click the 


OK button. 


 


Abstract Section 
Notice how everything in the first paragraph of the Abstract is using the stuff you typed into 


your Signature Sheet. Use the Abstract Text style for the text of the Abstract page. The 


Abstract has a page number, which will show in the Table of Contents, but the page number 


does not show on the Abstract page itself.  The Abstract may run onto more than one page; 


because of the sections and formatting, the template will automatically adjust to this, and so 


you will not need to change anything for the formatting to be correct.  There is also a small 


drop-down menu at the top of the page, from which you can select the title you will earn 


with the completion of this degree.  Like all the other sections of this document, the Abstract 


Section has a section break at the end of its last page, so make sure you don’t delete it.   
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Arabic Numerals Section (1,2,3,4…) 
The Arabic Numerals Section will contain the bulk of your document.  This section is devoted to 


most, if not all, of your writing: chapters, sections, subsections, Appendices, and References.  If 


you have an existing document you want to paste into the template, you will have to follow a 


series of instructions.  They are painful to follow, but once you are done, everything should fall 


into place.So do not despair, and stay with me. 


Copying from an Existing Document 


If you simply copied and pasted from an existing document into the template, you would get 


the formatting from the existing document that you do not want, as well as the text that you do 


want.  Below are the steps to avoid that problem. 


First, you want to create a backup copy of your existing document, so you can experiment with 


it, in case you do not get the whole process to work the first time.  The key is to find any kind 


of formatting that might violate the rules we have set up for the template.  To eliminate them, 


we are going to use the Find and Replace feature within Word.   


Use ctrl+h to pull up the dialog box.  Type ^l in the Find text field and ^p in the Replace text 


field.  This will remove any instances of page breaks, and replace them with returns (The trick 


to get this to work correctly is to click on Replace All until you either get 0 changes or a 


repeating number)  
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For the next one, you want to find ^t and Replace with [absolutely nothing], not even a blank 


space.  This one will remove any tabs from the document.   


For the next one, you want to find ^p^p and Replace with ^p.  We use this one to get rid of any 


instances of double spacing, and replace them with single spacing.   


Lastly, you will Find [two spaces] and Replace with [one space].  Doing so one will replace two 


spaces after words or periods, and replace them with just one space.   


Now that we are done removing additional formatting, we have to change the style of our 


document so it fits the style used in the template.  Use ctrl+h one last time, to Find [absolutely 


nothing]. Be wary because you might still have the empty spaces from the last search you 


performed. This is the part where it gets confusing. At the bottom left of the dialog box there 


is a More button, which you want to click on to pull up advanced features.  Now you’ll see a 


new section at the bottom left, which says Replace and has a drop-down menu under the 


Format button.  From it, you want to select Style… and pick the Normal style from the Find 


Style dialog box.  As for the Replace field box, you will do the same up to the Find Style Dialog 


box, but this time select the Body Text style.  Doing this will change the style for your entire 


document from Normal to Body Text.   


 


The last step is to go to the Word application options, to the Advanced tab. and to change all 


the Cut, copy, and paste options to Merge Formatting.  Now you can copy and paste into the 


template. 
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Styles 


As you may have noticed from looking at the rest of the document, pretty much everything in it 


has a Style.  Unless you are familiar with Styles, you will have absolutely no idea what I’m 


talking about.  If you look in the Home tab, under the Styles group (which is found within the 


ribbon) you will see a series of boxes.  By default, the Normal Style will be highlighted.  The 


template contains a range of styles, from Body Text (which makes up the bulk of your 


document), to Headings (which will be your chapter, sections, and subsection titles), to Object 


(which will be applied to visuals).  Knowing when to use which style is key to using this 


template successfully.  But just because we’ve designed the Heading styles for you does not 


mean that they are final!  You are free to format any of these styles in any way you want, so 


long as they are consistent and do not impair readability.  .  To Format a Style, right-click on it 


from the Quick Style Gallery, and select Modify; this will prompt the Modify Style dialog box.  


Any changes you make to a style will be reflected by any text that uses it. 


To apply a style to a letter, word, sentence, or block of text, go to the line that contains it, and 


either select the style, or highlight the specific text and then select the style from the Quick 


Style Gallery 


Chapters 


Use the Heading 1 style to format all your main headings (List of Tables, List of Figures, 


Abstract, chapter titles, Appendix titles, References, etc.) correctly. Use the Heading 2 style for 


subheadings. Check with your publication manual (APA, MLA, Chicago, etc.) to make sure that 


your Headings 1 and  2 match whatever your publication manual requires.  If you followed the 


instructions listed in the “Copying from an Existing Document” section, you will notice that all 


of your chapter headings have been turned into Body Text, so you will have to reassign them as 


chapter headings by using the appropriate heading tyle.  Upon applying a heading style to text, 


that text will be added to the Table of Contents, but only once you update that field. 
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Text 


The Normal style is only used in the references section so that Zotero can format the citations. 


Pressing Enter 


When you press enter you will get a paragraph mark (^p). Most of the time, this is exactly what 


you want. This template uses manual line breaks (^l) in some places; please leave them as they 


are. 


Tables, Figures, and Equations 


Captioning the objects in your document does not have to be a chore. To make it easier for you, 


we’ve come up with a really simple system.  We call this the “Three, Two, One method,” and it 


goes as follows: 


1. You want to press the Enter key three times; turning on Show/Hide should make this 


easier. 


2. Apply the Buffer Style to the top and bottom lines. 


3. Apply the Object Style to the middle line, and then insert the object into that line. 


If you’ve done everything correctly, it should look something like this: 


 


Once you insert an object into the document using this method, you can go ahead and caption 


it so it will appear in the appropriate list (Tables in List of Tables, Figures in List of Figures, and 


so on.)  You can caption an object by selecting it, then going to the References tab and clicking 


on Insert Caption from the Captions group. You can also right-click on the object and select 


Insert Caption from the menu.  This will prompt the Caption dialog box, where you will name 


the object, select what type it is (Table, Figure, Equation), and check the position of the caption 


relative to the object.  To name the object, simply write in the text box at the top.  Once you 


change the label type, it will automatically adjust the position of the caption to either above or 


below, please note that the position of the caption is the whole reason we used two buffer lines. 
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In the case of Tables and Figures, if, instead of using a Word or Excel Table, you decide to 


include a picture of a Table, you will still need to use the Table label.   


When referring to objects within your document, avoid the urge to type out “See Figure 1” or 


any such messages, since if you add another Figure before Figure 1, Word will automatically 


renumber them, and you’ll then have to renumber any references to that Figure within your 


text.  To avoid this, you will use the Cross-Reference feature in Word.  To use this feature, 


select in your document where you want to place the reference, go to the References tab, and 


click on Cross-reference from the Captions group.  This will prompt the Cross-reference 


dialog box, from which you will select the Reference Type (If you do not see Table or Figure in 


the drop-down menu, scroll down to find them). Select how you want the reference to be 


displayed (As just the label, the whole caption, the page number, or a combination of them) 


and click on the Insert button at the bottom of the dialog box.  These references will be 


automatically renumbered if you decide to add or move your objects. 


 






